# Table of Contents

## Chapter 1: About This Release

- Version Information ................................................................................................................. 5
- New Features ............................................................................................................................. 5
  - A2iA Recognition Engine Upgrade .......................................................................................... 5
  - Associative Search Databases ................................................................................................ 5
  - Database Lookup Improvements ............................................................................................. 6
  - FineReader Recognition Engine Upgrade ............................................................................... 7
  - RecoStar Recognition Engine Upgrade .................................................................................. 7
  - Trainable Locator ..................................................................................................................... 7
- Changes in Behavior .................................................................................................................. 8
  - Add Session Timeout for User Modules ................................................................................. 8
  - Bar Code Settings Change ..................................................................................................... 8
  - Cannot Merge Documents that are not Neighbors in Document Review ................................. 9
  - Document Review - Refresh Document Viewer ...................................................................... 9
  - Database Locator Word Confidences ..................................................................................... 9
  - Highlight All Lassoed Words in Document Viewer ................................................................. 10
  - Parallel Kofax Transformation Modules and Kofax Transformation Toolkit Installations ....... 10
  - Scripted Database Lookup Window Deprecated ..................................................................... 10
  - Unable to Import or Export Classification Instructions .......................................................... 10

## Chapter 2: Resolved Issues

- Kofax Transformation Modules 6.1.0 Fix Packs ...................................................................... 11
  - Kofax Transformation Modules 6.1.0 Fix Pack 10 ................................................................ 11
  - Kofax Transformation Modules 6.1.0 Fix Pack 9 .................................................................. 11
  - Kofax Transformation Modules 6.1.0 Fix Pack 8 .................................................................. 14
  - Kofax Transformation Modules 6.1.0 Fix Pack 7 .................................................................. 15
  - Kofax Transformation Modules 6.1.0 Fix Pack 6 .................................................................. 16
  - Kofax Transformation Modules 6.1.0 Fix Pack 5 .................................................................. 17
  - Kofax Transformation Modules 6.1.0 Fix Pack 4 .................................................................. 17
  - Kofax Transformation Modules 6.1.0 Fix Pack 3 .................................................................. 18
  - Kofax Transformation Modules 6.1.0 Fix Pack 2 .................................................................. 18
  - Kofax Transformation Modules 6.1.0 Fix Pack 1 .................................................................. 19
  - Thin Client Server 6.1.0 Fix Pack 10 .................................................................................... 22
  - Thin Client Server 6.1.0 Fix Pack 9 ...................................................................................... 22
  - Thin Client Server 6.1.0 Fix Pack 8 ...................................................................................... 24
Thin Client Server 6.1.0 Fix Pack 7.................................................................24
Thin Client Server 6.1.0 Fix Pack 6.................................................................25
Thin Client Server 6.1.0 Fix Pack 2.................................................................25
Thin Client Server 6.1.0 Fix Pack 1.................................................................25

Chapter 3: Known Issues..................................................................................27
  K32GetModuleInformation Error.........................................................................27
  Database Lookup Sorting Behavior for Thin Client Validation.........................27
  No Registration Applied for Training Documents in Extraction by Automatic Table Locator........27
  RecoStar Operating System Support............................................................28
  Root Element Error when Documents Copied via Drag & Drop.....................28
  Uninstalling Kofax Transformation Modules 6.2.0.........................................28
  Upgrading Kofax Transformation Modules 5.5 with A2iA..............................28
  Upgrading Kofax Transformation Modules....................................................29
  Clear Thin Client Browser History..............................................................29
Chapter 1

About This Release

This set of release notes contains important information not included in other Kofax Transformation Modules documentation. Please read these release notes carefully before you install, upgrade, or use this product.

Information about supported operating systems and other requirements is available on the Kofax Support website at www.kofax.com.

Version Information

The Kofax Transformation Modules 6.2.0 release has the following build number, which appears in the About Kofax window:

6.2.0.0.0.6620.

New Features

The following new features are available in Kofax Transformation Modules 6.2.0.

A2iA Recognition Engine Upgrade

The A2iA CheckReader engine has been upgraded to version 6.0, the DocumentReader was upgraded to version 6.0, and the FieldReader was upgraded to version 5.5. This upgrade provides support for Windows 10.

Associative Search Databases

This new type of database uses a fuzzy search algorithm for database searches. This type of database is able to better differentiate the best alternative and the second best alternative, than a regular fuzzy database. As a result, there are fewer false negatives than a fuzzy database.

When using an Associative Search Database as input for a Database Locator, it may be beneficial to amend the Regions settings. By default, all pages are taken into account and the entire text of every page is searched. This behavior is fine when using an Associative Search Database, no matter what type of document is being processed.

However, these default Regions settings are not ideal when processing an invoice. This is because non-tabular data on an invoice is usually in a consistent location on a document. For example, using
Regions to search the top 35% and the bottom 35% of a document only, can provide better accuracy and performance when extracting the customer address on an invoice.

Since both associative search databases and fuzzy databases use CSV files, it is not always obvious when to use which type of database. The following may help.

- The Associative Search Database type is faster and more accurate than fuzzy databases.
- If the database source file must be accessible from a URL, a Fuzzy Database must be used. This functionality is not available for an Associative Search Database.
- To normalize a search or database record using replacement text, a Fuzzy Database must be used. This functionality is not available for an Associative Search Database.
- An Exclusion database can be added to a Fuzzy Database only.
- Associative search databases support ANSI and Unicode little Endion encoding for their CSV files only. Also, the first character of the CSV file is expected to be a BOM character.
- Fuzzy databases also support UTF-8 and Big Endion encoding for their CSV files.
- When using an Associative Search Database as input for a Database Locator, the search results are not highlighted on a document as they are for fuzzy databases.

Database Lookup Improvements

Database lookups that are performed during Validation have been improved as follows.

Immediate Search for Fuzzy and Associative Search Databases

When adding a database lookup button to a Custom Validation form that references either a Fuzzy Database or an Associative Search Database, it is now possible to configure the lookup to use the Immediate Search feature.

For relational databases, if there is a single matching record, the validation form is automatically populated with the mapped fields. If there are multiple results, the search window is displayed and the user can select a record or perform another search.

For fuzzy databases or associative search databases, if there is a single record returned with 100% confidence, the validation form is populated automatically with this record. If however, the search returns multiple records, no records, or a single match with a lower confidence, the search results window is displayed and the user can select a record or perform another search.

Search Behavior for Relational Databases

If a database lookup is configured to use a relational database, it is now possible to define the search behavior.

There are two choices for the search behavior in the database lookup window.

**Per column**

When selected, the Validation user must type a search string into an individual column in the search window. Only that column is searched for entries with a matching string.
All Columns
When selected, the individual search field for each column are replaced with a single search field. Values entered here are searched for in all columns of the database.

This means that if a database lookup is configured for All columns, it is no longer necessary for the Validation User to know what is contained in each column of the database.

Operators and Wild Cards with Relational Database Searches

Regardless of the search behavior, it is now possible to add standard operators to the search string for numeric or date fields. These operators are $<$, $>$, $>$+, $<$, $<$+, and $=$.

For example, if you enter a value of $<10$ into a numeric or date field, the search finds all records that have a value of less than ten. Any values in a string column must contain the search string. If the same example is entered into a text field, "House$<1023>$" is found because it contains the search string.

For database columns with the string type, it is also possible to use wild cards as part of the search text. If wild cards are already configured for this lookup, that behavior is overridden.

For example, a search for %No returns and word that starts with this string, such as "November," "Note," "Notice," etc.

Scripted Database Lookup Window to be Deprecated

If you have any scripted database lookups, this functionality will be removed in the next release. Because of this, it is recommended to convert all of your scripted database lookups to a regular database lookup by adding a lookup button to a Custom Validation Form.

FineReader Recognition Engine Upgrade

The Abbyy FineReader recognition engine has been upgraded to version 11.1 R8. This upgrade provides support for Windows 10.

RecoStar Recognition Engine Upgrade

The RecoStar recognition engine has been upgraded to version 7.5. This upgrade provides support for Windows 10.

Trainable Locator

The new and highly optimizable Trainable Evaluator provides good and quick generic extraction results with a relatively small training set. This evaluator is used to compare alternatives from other locators and to determine which of those alternatives match a specific set of criteria. This evaluator relies on alternatives from the input locator. It also learns from false alternatives to improve training.

An input locator provides a set of alternatives for each subfield. The Trainable Evaluator uses its training data to verify which of the input locator alternatives is the best results for the assigned subfield.

Input locators should provide input, but they should not be too complicated, as these are executed during training and during extraction.
For example, a project contains a Format Locator that returns all of the amounts found on a document. This Format Locator can be used as input to the Training Evaluator and train it to specifically locate the "Total" from the Format Locator amount alternatives.

The location of the Trainable Evaluator in the list of locators in a class is important. Only those locators listed about the Trainable Evaluator can be used as input locators. Since subfields are independent of each other, their order does not affect how they are processed. This means that you can organize the subfields in any way without affecting the output.

The input locator must be a simple locator. A Table Locator, an Advanced Zone Locator, or a group locator cannot be used as input for a Trainable Evaluator.

This evaluator is ideal when high out-of-the-box generic pre-trained extracted is desired. Because input locators are defined by the project administrator, they have a lot of influence over the alternatives that are considered for extraction. This is because they can configure and fine tune the input locators and script events. The Trainable Evaluator also learns quickly and with fewer samples, so it is not necessary to train a lot of documents.

Changes in Behavior

The following changes have been made to the behavior of Kofax Transformation Modules 6.2.0

Add Session Timeout for User Modules

Kofax Transformation Modules now supports a session time out feature that was implemented in Kofax Capture. The affected user modules are Correction, Document Review, Validation (1-5), and Verification.

This feature is available only if you have Kofax Capture 10.1.1.5 with Hotfix 4841 installed. The "Time out after inactivity of X minutes" option is configured in Kofax Capture Administration, under Tools > Profiles > Edit a user or group.

To ensure you have access to this feature in the user modules, follow these steps:

1. Open Kofax Capture Administration.
2. Go to Tools > Custom Modules.
The Custom Modules Manager window is displayed, listing all of the existing modules.

   **Note** Do not delete any modules before adding them again. You only have to update KTM Correction, KTM Document Review, KTM Validation (1-5), and KTM Verification.

3. Click Add and select a user module, and then click Install.
4. Repeat until all affected user modules are reinstalled.

Bar Code Settings Change

When a project is upgraded from Kofax Transformation Modules 6.0 to version 6.1, a Bar Code locator that was configured to use the "Data Matrix" type is now configured to use the "UCC 128" bar code type instead.
This configuration change improves the recognition of this bar code type.

**Cannot Merge Documents that are not Neighbors in Document Review**

Multi-selection using Shift + Arrow keys is now working as expected.

For non-neighboring documents, a "Mark Mode" was added that allows users to mark multiple documents and handle them like selected documents.

The "Mark Mode" is enabled via the View menu and its state is displayed in the Status bar.

This mode displays check boxes on the document level to mark documents. The default key to enable the checkbox is the Space key.

**Note** As long as no documents are selected while in "Mark Mode", document selection behaves as normal.

If a user goes into "Mark Mode" when other documents are already selected, that selection is lost.

You can override the default shortcuts via the project settings.

For more information on the "Mark Mode", see the Document Review help.

**Document Review - Refresh Document Viewer**

The following menu options are now available for multi-page documents as well as the entire batch.

- Copy Page to New Document
- Rotate 180°
- Rotate All Pages of Document to the Left
- Rotate All Pages of Document to the Right
- Rotate All Pages of Document 180°
- Rotate All Pages of Batch to the Left
- Rotate All Pages of Batch to the Right
- Rotate All Pages of Batch 180°

**Database Locator Word Confidences**

When hovering over a field value, the confidence for each individual field is now displayed within the Database Locator window on the Results tab.

The value of this confidence can be accessed in script using the following:

```pXDoc.Locators.ItemByName("DatabaseLocatorName").Alternatives.ItemByIndex(AlternativeIndex).SubFields.ItemByIndex(SubFieldIndex).IndividualConfidence```

This value has been added for scripting purposes only. It does not affect the confidence of the fields filled by the Database Locator.
Highlight All Lassoed Words in Document Viewer

Highlighting is now continuously active when navigating between pages in the Document Viewer window in Validation.

Parallel Kofax Transformation Modules and Kofax Transformation Toolkit Installations

It is no longer possible to install Kofax Transformation Modules and Kofax Transformation Toolkit in parallel. This configuration is no longer supported.

Scripted Database Lookup Window Deprecated

It is no longer possible to add a scripted database lookup window to a customized Validation form. Instead, add a regular database lookup button. All functionality is available in this lookup button.

Unable to Import or Export Classification Instructions

It is now possible to successfully import and export classification instructions.

The import / export tools are available only when the 'Instructions' element is selected.

The following behavior is available for instructions.

- The **Import As New** option appends the imported instructions to the selected locator class.
- The **Import** option deletes any existing instructions for the selected locator class before importing the new instructions.
- The **Export** option is available only when there is at least one instruction in the selected class. Save the exported instructions for import elsewhere.

The behavior of importing and exporting locators was also affected by these changes.

- The **Import As New** option will append the imported locator to the selected locator class and will be available only when the Locators element is selected in the project tree.
- The **Import** option will overwrite the selected locator. This option is available only when a locator is selected in the Project Tree.
- The **Export** option is available only when a locator that has an extraction method is selected in the Project Tree. Save the exported locator for import elsewhere.
Chapter 2

Resolved Issues

The following are the resolved issues in Kofax Transformation Modules.

Kofax Transformation Modules 6.1.0 Fix Packs

The following Fix Packs have been released for Kofax Transformation Modules and the Thin Client Server since 6.1.0 was released.

Kofax Transformation Modules 6.1.0 Fix Pack 10

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 5 (6.1.0.10).

801765 - Moving Pages with Keyboard Lags in Document Review

Document Review is now able to keep up when a user uses the keyboard to move from page to page.

775894 - Document Viewer Disappears in Subsequent Batches

This regression was introduced in the Kofax Transformation Modules 6.1.0.9 Fix Pack.

Document Viewer no longer disappears and is displayed as expected.

766535 - Table Cells Changed by Script can Fail in Validation

The row selection and updating values in multiple tables now works as expected.

697200 - Manual Change Considered System Change

When the final change to a field is a manual user change and that is performed after a script change, the user change is still recorded as a system change.

322006 - OK Button Disabled for Search Immediately Database Lookups

The OK button is now enabled when an Immediate Search database lookup returns multiple results.

Kofax Transformation Modules 6.1.0 Fix Pack 9

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.9).
764522 - PDF Text Mixes Word Order

PDF text is now handled correctly when using automatic word separation.

761696 - Intermittent De-Initialization Error

The de-initialization of parent script objects with active child objects has been fixed and this error no longer occurs.

761409 - PDF Text Imported Incorrectly

PDF text is now correctly imported because double-characters are correctly imported.

754908 - Conflict Resolution Reports Excessive Non-Conflicts

Excessive conflicts no longer occur because the Amount Group Locator no longer treats valid currency fields as a conflict.

754870 - Invalid PDF Text Layer causes Invoice Group Locator Errors

The Invoice Group Locator is now able to handle "empty" words. As a result, the Invoice Group Locator no longer fails for these PDF text layers that were previously considered invalid.

749028 - PDF417 Bar Codes not Recognized

The FineReader recognition engine is now updated, and PDF417 bar codes are successfully recognized by the Bar Code Locator.

747163 - OCR in PDFs is Rotated 90° while Image is not Rotated

The orientation of the PDF text layer is now rotated in accordance with the image.

746923 - Performance Issues when Loading Kofax Capture Fields

Loading Kofax Capture fields now behaves and performs as expected.

746442 - Extraction Training Data Not Saved

Extraction training data is now preserved when reloading the project.

745641 - Image Cleanup Causes Errors

An error no longer occurs when an Advanced Zone Locator with MICR lines use the "Remove Lines" image cleanup method.
745243 - Previous Document Field Values Shown in Validation

When you close or suspend a batch and the next batch is entirely valid, the validation form and the Document Viewer no longer display the last document of the previous batch. This means the user can no longer see a document and its values from the previous batch.

738691 - Cannot Merge Documents that are not Neighbors

Multi-selection using Shift + Arrow keys is now working as expected.

For non-neighboring documents, a "Mark Mode" was added that allows users to mark multiple documents and handle them like selected documents.

The "Mark Mode" is enabled via the View menu and its state is displayed in the Status bar.

This mode displays check boxes on the document level to mark documents. The default key to enable the checkbox is the Space key.

**Note** As long as no documents are selected while in "Mark Mode", document selection behaves as normal.

If a user goes into "Mark Mode" when other documents are already selected, that selection is lost.

You can override the default shortcuts via the project settings.

737516 - Option to Disable Rotate Warning in Document Review

A check box is now available in the message window that allows users to disable the rotate warning message.

731715 - Restrict Single Logon Session per Module

Users are now restricted to a single logon session per module.

727250 - Document Review - Refresh Document Viewer

The following menu options are now available for multi-page documents as well as the entire batch.

- Copy Page to New Document
- Rotate 180°
- Rotate All Pages of Document to the Left
- Rotate All Pages of Document to the Right
- Rotate All Pages of Document 180°
- Rotate All Pages of Batch to the Left
- Rotate All Pages of Batch to the Right
- Rotate All Pages of Batch 180°
712663 - Highlight All Lassoed Words in Document Viewer

Highlighting is now continuously active when navigating between pages in the viewer window in Validation.

712524 - Server Scheduler Service Rights and Permissions

It is recommended to run Server Scheduler Service with administrative rights.

However, if the following requirements are met, the Server Scheduler Service and its dependent processes can run without administrative rights.

When choosing a user account to run the Server Scheduler Service, the following are important:
- The standard guest user does not work.
- You can use a standard user.
- You can use a standard user and move them from the standard user group to the guest group.

SecurityBoost:
- When using SecurityBoost, the Server Scheduler Service user should be the SecurityBoost user, or at least have equivalent privileges.

Kofax Transformation Modules 6.1.0 Fix Pack 8

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.8).

284721 - Improve Batch Deletion in User Modules

A new setting in the Extended Synchronization Settings window is now available so that you can configure a batch class to delete an empty batch when closed.

Note Enabling this setting can cause problems if you are using partial batch release. A workaround is to use document routing to move all of your documents to other batches and then delete the empty batch that is left over.

670164 - Identify Fields Changed by User vs. System

When a field is modified the source of that modification is recorded and available when using KAFC.

Fields can be modified by the user or by the system, this includes database lookups and scripts.

676240 - View Average Time Spent Validating a Document

The user focus time for each document per module and is now measured and reported as ProcessingTime to Kofax Capture, when supported by Kofax Capture.

The user modules that support this new reporting feature are Document Review, Correction, Validation, Verification, Thin Client Correction, Thin Client Validation, and Thin Client Verification.
687698 - Database Locator Fails to Find Values

The Database Locator no longer excludes valid alternatives during extraction. Because of this, values are successfully found by the Database Locator as expected.

692716 - Reporting Fails for the Thin Clients

Reporting now behaves as expected for the Thin Clients.

701345 - A2iA CheckReader Error

The A2iA CheckReader now successfully processes Checks without error.

701346 - A2iA CheckReader Cannot Extract a Zero Amount

The amounts on zero dollar checks ($0.00) are now properly extracted.

717553 - Error with Many Documents and Trainable Document Separation

It is now possible to successfully process a large amount of documents using a project with Trainable Document Separation.

724221 - PDF Documents not Displayed Correctly

PDF documents are now rendered as expected.

728453 - Ability to Move Logs to New Log Path

Kofax Reporting has been upgraded to version 2.0.2. This enables you to specify a different log path.

733569 - Validation Hangs when Opening Multiple Instances

When multiple instances of Validation are opened quickly, it is no longer likely for one or more of these instances to lock up.

733423 - Server Scheduler Server Crashes

Additional checks are now carried out by the Scheduler Service to prevent crashing.

735129 - Verification Crashes in APP-V 5.1 Environment

The Verification module no longer crashes when running in an APP-V 5.1 environment.

Kofax Transformation Modules 6.1.0 Fix Pack 7

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.7).
711355 - Extensive Use of External Knowledge Bases Memory Problems
Training information from the Knowledge Bases is now stored in cache to reduce memory consumption.

706845 - Doubled Characters from PDF Text Imports
A PDF with embedded text is now extracted once only, ensuring that there are no duplicate characters.

705905 - Application_InitializeBatch Property Not Working
You can now successfully use the CscClass.ShowInKeyingModules property in Document Review and Validation as expected.

697577 - Purple Highlighting for Related Text not Working
When a field for a Trainable Group Locator is selected in the Edit Document window, related keywords are once again highlighted purple.

695711 - Add Ability to Expand All Documents when Opening Document Review
A new value for the "Document display behavior" option on the Batch settings tab in the Document Review Setting window is now available.

Batches can now be configured so that all documents are expanded automatically when the batch is opened.

Kofax Transformation Modules 6.1.0 Fix Pack 6
The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.6).

692795 - ReliableFileSystem Element in ACConfig Ignored
High Availability now performs as expected in Document Review.

691555 - Embedded PDF Text not Read Correctly
PDFs with embedded text are now processed and extracted as expected.

688759 - Window Position and Viewer Settings not Remembered in Document Review
The size and position of Document Review and its docked Viewer within the window, are now retained when a user closes the application. If the Viewer is floated, its position reverts to the default docked state.
Kofax Transformation Modules 6.1.0 Fix Pack 5

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.5).

694166 - Database Locator Error with Encrypted Database
Using a large encrypted database no longer causes an exception error.

689220 - Data Extracted Twice for PDF Text Layer
When a PDF document is processed, data is extracted only once as expected.

687169 - Error with Microsoft Text ODBC for CSV Files
A problem no longer occurs when using the Microsoft Text ODBC driver to process *.csv files.

670164 - Identify Fields Changed by User vs. System
When a field is modified the source of that modification is recorded and available when using KAFC.
Fields can be modified by the user or by the system, this includes database lookups and scripts.

667014 - A2iA CheckReader Allows Unlicensed Settings
It is no longer possible to configure unlicensed settings when using the A2iA CheckReader.

606702 - AfterFieldChanged Not Called in InPlace Editor
The InPlace Editor is now reacting on the `AfterFieldChanged` event.

Kofax Transformation Modules 6.1.0 Fix Pack 4

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.4).

688993 - Document Review Crashes on Close
Document Review no longer crashes when closed.

686170 - PDF Orientation not Displayed Correctly in XDoc Browser
A PDF document is now displayed with the correct orientation in the XDoc Browser.

682803 - KTM for Forms Project Uses KTM Unlimited Page Count
When the KTM for Forms license is applied, the page count for other licenses is no longer consumed when a project uses ‘basic features’ only.
633494 - Add Session Timeout for User Modules

Kofax Transformation Modules now supports a session time out feature that was implemented in Kofax Capture. The affected user modules are Correction, Document Review, Validation (1-5), and Verification.

This feature is available only if you have Kofax Capture 10.1.1.5 with Hotfix 4841 installed. The "Time out after inactivity of X minutes" option is configured in Kofax Capture Administration, under Tools > Profiles > Edit a user or group.

To ensure you have access to this feature in the user modules, follow these steps:

1. Open Kofax Capture Administration.
2. Go to Tools > Custom Modules.
   The Custom Modules Manager window is displayed, listing all of the existing modules.
   
   **Note** Do not delete any modules before adding them again. You only have to update KTM Correction, KTM Document Review, KTM Validation (1-5), and KTM Verification.

3. Click Add and select a user module, and then click Install.
4. Repeat until all affected user modules are reinstalled.

Kofax Transformation Modules 6.1.0 Fix Pack 3

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.3).

671100 - Document Routing Fails for Locked PDFs

PDF files are no longer locked to another process when document routing is performed.

669745 - Validation Does Not Release the Handle to the Batch

When a batch in Validation is closed, all handles to the batch are successfully released.

Kofax Transformation Modules 6.1.0 Fix Pack 2

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.2).

663426 - Project Builder Shortcut Keys not Working on Russian System

All ribbon shortcuts are available when using the Russian language pack for all Kofax Transformation Modules modules and applications.

The algorithm used to generate shortcut keys has been improved. Characters with diacritical marks are no longer used as shortcut keys.

656954 - Shortcut Keys not Working with Japanese Language Pack

Shortcut keys now work as expected, even when using the Japanese language pack.
656882 - XValues Not Always Loaded

XValues are now always available for document sets when an Extraction Benchmark is performed.

652721 - Bar Code Types Not Available

The Patch, Post Net, UCC 128 and UPC-A bar code types can now be successfully assigned to a Bar Code Locator.

648779 - Structured Exception when Configuring an SQL Database

During configuration in Project Builder, databases with a large number of tables no longer causes problems.

Bugs 648770 and 643166 were fixed as a result of this bug.

642141 - Bar Code Settings Change

When a project is upgraded from Kofax Transformation Modules 6.0 to version 6.1, a Bar Code locator that was configured to use the "Data Matrix" type is now configured to use the "UCC 128" bar code type instead.

This configuration change improves the recognition of this bar code type.

612972 - Classify Document in Project Builder Takes Long Time

The performance of the "Classify Selection" option in Document Viewer has been improved. Testing classification in Project Builder no longer takes a long time when there are complex Instructions.

365468 - Database Locator Returns Encrypted Records

The Database Locator now decrypts more entries before post-processing occurs. This ensures that the best result is returned.

Kofax Transformation Modules 6.1.0 Fix Pack 1

The following problems have been resolved in Kofax Transformation Modules 6.1.0 Fix Pack 4 (6.1.0.1).

641142 - Purchase Order Discovery Processing Takes a Long Time

It no longer takes a long time to process documents that have a lot of open purchase orders in the database when doing purchase order discovery for an Oracle database.

635996 - Could Not Open File

Kofax Transformation Modules can successfully load and save XDocuments back to Kofax Capture because the Reliable File System, also known as High Availability, is now supported for the failing action.
635928 - Keyword Highlighting Fails in Edit Fields Window

Keyword highlighting is now working as expected in the Edit Fields window.

633875 - Field Validation Rules Run in Document Review when no Field Data

Field Validation rules are no longer executed if batch editing actions such as splitting a document, are performed in Document Review.

630564 - Web Dictionaries and Databases Cannot be Used

It is now possible to successfully add a dictionary or import a fuzzy database using a remote URL.

627636 - Database Locator Word Confidences

When hovering over a field value, the confidence for each individual field is now displayed within the Database Locator window on the Results tab.

The value of this confidence can be accessed in script using the following:

```
pXDoc.Locators.ItemByName("DatabaseLocatorName").Alternatives.ItemByIndex
(AlternativeIndex).SubFields.ItemByIndex(SubFieldIndex).IndividualConfidence
```

This value has been added for scripting purposes only. It does not affect the confidence of the fields filled by the Database Locator.

627743 - Database Locator Issue When Duplicate Words Appear in Same Row

A new setting is now available for the Database Locator. The new **Maximum distance to concatenate numbers (mm)** option is located on the General tab and enables users to specify the maximum distance in millimeters for which separated digits or numbers in the text representation are considered part of the same number. Characters that are located outside of this maximum distance are recognized as distinct numbers.

**Note** This works only for numerical characters.

624316 - Different Classification Results for Project Builder and Runtime

The classification results seen when testing documents in Project Builder now match the classification results returned during production.

619858 - Advanced Zone Locator Subfields Ignored

Advanced Zone Locator subfields are now successfully mapped to group member zones, even if anchor registration fails.
618789 - Project Builder Crashes During FineReader Page or Zone Recognition

Project Builder no longer crashes when a large dictionary is added to a FineReader Page or Zone profile.

613080 - Validation Crashes with Character Exact Editing is Enabled

For new batches, Character Exact Editing is now working as expected when the Always CAPITAL letters option is enabled.

607505 - Classification Instructions Missing Horizontal Scrollbar

The scrollbars are now available when viewing classification instructions.

607497 - Classification Instructions not Sorted in Alphabetical Order

Classification Instructions are now sorted in alphabetical order.

607495 - Cannot Edit OCR Text in Document Viewer

It is now possible to edit and save the OCR text for some documents in the Documents window. The save button is enabled for documents in the Classification Set only.

606480 - Validation Rule Creation Failure

A conditional check has been added in the code to ensure that inherited Validation Rules are no longer deleted erroneously.

562157 - Unable to Import or Export Classification Instructions

It is now possible to successfully import and export classification instructions.

The import / export tools are available only when the 'Instructions' element is selected.

The following behavior is available for instructions.

- The Import As New option appends the imported instructions to the selected locator class.
- The Import option deletes any existing instructions for the selected locator class before importing the new instructions.
- The Export option is available only when there is at least one instruction in the selected class. Save the exported instructions for import elsewhere.

The behavior of importing and exporting locators was also affected by these changes.

- The Import As New option will append the imported locator to the selected locator class and will be available only when the Locators element is selected in the project tree.
- The Import option will overwrite the selected locator. This option is available only when a locator is selected in the Project Tree.
- The **Export** option is available only when a locator that has an extraction method is selected in the Project Tree. Save the exported locator for import elsewhere.

271125 - Allow Modification of Class Properties at Runtime

Portions of the `CscClass` object are now supported by Kofax Transformation Modules.

The supported object and properties are as follows.

- `CscClass`
  - `CscClass.ShowInKeyingModules` - Specifies if this class is to be shown in the re-classification combo box in Validation and Document Review.
  - `CscClass.ValidClassificationResult` - Specifies if this class is a valid classification result.

These properties can be used in the following script events.

- `Application_InitializeScript`
- `Application_InitializeBatch`
- `Batch_Open`

Thin Client Server 6.1.0 Fix Pack 10

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 10.

766535 - Table Cell Script Changes Failing in Thin Client Validation

The row selection and updating values in multiple tables, now work as expected.

799987 - Wrong Error Message with Incorrect Password

The correct error message is now displayed when a user enters an incorrect username or password into one of the Thin Client modules.

800694 - Monitor for Automatic Learning ignored by Thin Clients

The "Monitor for Automatic Learning" field setting is now supported by Thin Client Validation.

As a result, a monitored field that is modified during Thin Client Validation is automatically trained for extraction online learning.

867562 - Space Character Finds no Results in Database Search

Search results are now returned successfully when a space character is used in a database lookup.

Thin Client Server 6.1.0 Fix Pack 9

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 9.
647080 - Multiple Application Vulnerability on Thin Client Server
Output encoding has been implemented in Thin Clients, resolving an application vulnerability.

Batch logging has been added to the Thin Clients. This needs to be configured in Web.config file, KCThinClientModule.exe.config file and KTM_ExtendedLogging system variable.

707945 - Database Lookup has Un-Encoded Field Data
Encoding has been implemented for database lookups.

707947 - Rejected Notes Not Encrypted
Encoding has been implemented for Sticky Notes that are rejected.

710809 - Error Displaying Image during Thin Client Validation
Images are now correctly displayed during Thin Client Validation.

714076 - Better Error Messages when Leaving or Refreshing Page
Forced page refresh via F5 is now suppressed by Thin Client Server for Internet Explorer version 9, 10 and 11 and Firefox.

746224 - Average Time Spent on Document not Updated
Added logic to update the time span and keystrokes in the xfd file. ProcessingTime is now updated correctly in Kofax Capture for Thin Client Correction.

747146 - Thin Client ApplicationPool Process Memory Leak
There is no longer a memory leak with the ApplicationPool process.

748277 - Classification Result Column Constantly Loading
The classification results are no longer constantly loading.

756030 - Database Connections Do Not Close with Batch
Database connections are now closed when unloading the project from Thin Client Validation. This either happens when a different project is loaded or when the database timeout is hit (as defined in the DB connection string).

In addition only one connection per database that is used on a database lookup button is opened during project load and kept open until the project is closed.
763830 - Image Viewer and Index Fields not Updated

The folder index calculation was fixed to work with updated browsers versions, so that page and fields are now displayed as expected.

Thin Client Server 6.1.0 Fix Pack 8

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 8.

671033 - Identify Fields Changed by Thin Client User vs. System

When a field is modified the source of that modification is recorded and available when using KAFC. Fields can be modified by the user or by the system, this includes database lookups and scripts.

676240 - Display Average Time Spent Validating a Document

The user focus time for each document per module and is now measured and reported as ProcessingTime to Kofax Capture, when supported by Kofax Capture.

The Thin Client user modules that support this new reporting feature are Thin Client Correction, Thin Client Validation, and Thin Client Verification.

692716 - Reporting Fails for the Thin Clients

Reporting now behaves as expected for the Thin Client Server.

711677 - Scroll Position Jumps in Relational Database Lookup Window

The focus on a the selected cell in a lookup window is now retained, without changing the scroll position.

724221 - PDF Documents not Displayed Correctly

PDF documents are now rendered as expected.

728453 - Move Transformation Logs to New Log Path

Kofax Reporting has been upgraded to version 2.0.2. This enables you to specify a different log path.

Thin Client Server 6.1.0 Fix Pack 7

The following problem has been resolved in Thin Client Server 6.1.0 Fix Pack 7.

690035 - Field Values Not Displayed Correctly

The Batch Structure view now displays field values when the "Use as Display Field Selection" option is enabled for that field.
Thin Client Server 6.1.0 Fix Pack 6

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 6.

682150 - Force Valid with Validation Rules Fails in Thin Clients
If a field has a multi-field validation rule, it is now possible to successfully force that field valid.

681686 - Force Valid Icon Missing in Thin Client Validation
The Force Valid icon is now displayed as expected when using a combo box.

656750 - Thin Clients are Slow to Open Batches
Batches selected from the batch list are now opened in a timely manner.

Thin Client Server 6.1.0 Fix Pack 2

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 2.

635346 - Combo Box Cannot be Changed from Script
The JavaScript has been updated to allow you to now update a combo box from script.

629600 - Right-To-Left not Working in Thin Client Validation
Fields configured for Right-to-Left alignment are now displayed as expected in Thin Client Validation.

Thin Client Server 6.1.0 Fix Pack 1

The following problems have been resolved in Thin Client Server 6.1.0 Fix Pack 1.

640593 - Combo Box Font Size Mis-match in the Thin Client Validation
The font size applied to a drop-down list in a validation form custom layout in Project Builder is now displayed correctly in Thin Client Validation.

640288 - AfterSplitDocument Event Issue in Thin Client Validation
The AfterSplitDocument event in Thin Client Validation now works as expected by splitting documents as requested.

635346 - Document Unconfident but Valid in Thin Client Validation
When a combo box is marked as valid for the first time, the corresponding document no longer needs to be confirmed a second time.
626911 - Thin Client Validation Needs to Close Empty Batch

Thin Client Validation users are now prompted to delete an empty batch if they attempt to close that batch. If they do not delete the batch, the only way to move on to the next batch is to suspend the empty batch.

593365 - Memory Problem for Thin Client Server with Large Batches

Thin Client Correction batches that call scripts are no longer sent to Quality Control. The script engine is now correctly initialized and batches with scripts are processed as expected.
Chapter 3

Known Issues

The following sections describe known problems, and if available, useful workarounds for Kofax Transformation Modules 6.2.0.

K32GetModuleInformation Error

A "K32GetModuleInformation could not be located" error is encountered while loading a project in a Windows Server 2008 SP2 environment.

This is because the RecoStar 7.5 recognition engine does not support the Windows Server 2008 SP2 operating system.

Workaround: Use a different recognition engine if possible or upgrade your operating system.

(886265)

Database Lookup Sorting Behavior for Thin Client Validation

If you sort a column in the database lookup window and then close that window, the next time you open the database lookup window, whether it is the same document or another document, the previous sort filter is already applied.

(862485)

No Registration Applied for Training Documents in Extraction by Automatic Table Locator

When the Table Locator is in automatic mode and has training enabled, it does not make use of the registration settings that are set on the training documents. This does however, work for manual mode.

Workaround: Classify the affected documents to a separate class and then use a manual Table Locator.

Important This workaround does not work for automatic online learning.

(842154)
RecoStar Operating System Support

Even though Kofax Transformation Modules supports Windows Server 2008 Service Pack 2, the RecoStar recognition engine does not support this operating system.

**Workaround:** Use a different recognition engine if possible or upgrade your operating system.

Root Element Error when Documents Copied via Drag & Drop

When documents are copied via drag & drop, an error can occur when the project is trained or when the documents are sorted on disk.

**Workaround:** When presented with this error, press the Ignore or the Ignore All button. Doing so repairs the defective documents.

(630605)

Uninstalling Kofax Transformation Modules 6.2.0

The removal of Kofax Transformation Modules 6.2.0 can fail because the Server Scheduler service does not always stop in a timely manner when requested by the installer.

**Workaround:** Stop all Kofax Capture and Kofax Transformation Modules services before attempting an uninstall.

(619511)

Upgrading Kofax Transformation Modules 5.5 with A2iA

After upgrading to Kofax Transformation Modules 6.2.0 when the A2iA recognition engine is installed, some folders are not properly removed.

**Workaround:**

Remove the following folders:
- For x64 operating systems: `<Program Files (x86)\\Common Files\\Kofax`
- For x86 operating systems: `<Program Files\\Common Files\\Kofax`

Remove the following subfolders:
- `A2iADR30` (when upgrading from versions 5.5 to 6.0.2),
- `a2ia343` (when upgrading from versions 5.5 and 6.1),
- `a2ia363` (when upgrading from version 6.0.2 only)

(619502)
Upgrading Kofax Transformation Modules

Before you install Kofax Transformation Modules 6.2.0, reboot your server twice before you begin the installation. This ensures that the installation is successful.

(608620)

Clear Thin Client Browser History

After an upgrade, certain Thin Client features do not work as expected.

Workaround: Clear the browser history and then restart IIS.